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Preface

This manual is written for engineers and scientists who have some experience

with programming and working with instruments. It assumes some

knowledge of Microsoft RŒ Windows and your Personal Computer (PC).

There are three chapters:

– Chapter 1, \Installing HP VEE for Windows," shows how to install HP VEE

on your PC. The installation is primarily automatic, and should only take a

few minutes if your PC is already set up.

– Chapter 2, \Quick Start," takes you through some simple, hands-on

exercises that quickly show you how to work within HP VEE and create

HP VEE programs. The best way to learn how to use HP VEE is to follow

along, doing these exercises sequentially on your computer. This will take

about an hour and a half, but you can stop for a break at any time.

– Chapter 3, \Some HP VEE Programming Techniques," illustrates some

selected HP VEE programming techniques.
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Conventions Used in this Manual

This manual uses the following typographical conventions:

Example Represents

HP VEE Reference Italicized words are used for book titles and for emphasis.

File Computer font represents text you will see on the screen,

including menu names, features, buttons, or text you have to

enter.

dir Õlename In this context, the word in computer font represents text you

type exactly as shown, and the italicized word represents an

argument that you must replace with an actual value.

File ¡¡) Open The \¡¡)" is used in a shorthand notation to show the

location of HP VEE features in the menu. For example,

\File ¡¡) Open" means to select the File menu and

then select open.

Zoom Out | In 2x | In 5x Choices in computer font, separated with a bar (|), indicate

that you should choose one of the options.

ÄReturnÅ The keycap font graphically represents a key on the PC

keyboard.

Press ÄCtrlÅ+ÄOÅ Represents a combination of keys on the PC keyboard that you

should press at the same time.

Dialog Box Bold font indicates the Õrst instance of a word deÕned in the

glossary.
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Installing HP VEE for Windows

This chapter tells how to install HP VEE for Windows. The installation is

primarily automatic, and requires only a few minutes if your PC is already set

up and running.

Before you can install HP VEE for Windows, you'll need to install Microsoft RŒ

Windows (version 3.1 or a later version) and MS-DOS RŒ (version 5.0 or a later

version) on a personal computer meeting the following requirements:

– Microprocessor:

Minimum: 80386, 33 MHz or faster, with 80387 coprocessor.

Recommended: 80486, 33 MHz or faster.

– RAM (Random Access Memory):

Minimum: 12 MB (megabytes).

Recommended: 16 MB.

– Display system:

Minimum: VGA (640-by-480).

Recommended: Super VGA (800-by-600) or Ultra VGA (1024-by-768).

– Mass storage:

A 3.5-inch (1.44 MB) Œoppy disk drive, and a hard disk drive with at least

15 MB of free disk space.

Before you install the software, install any hardware I/O interfaces that you

intend to use. The following I/O interfaces are supported:

– PC serial ports (COM1, COM2, COM3, and COM4).

– HP 82335 and HP 82341 HP-IB Cards. Install each HP-IB (IEEE-488) card

following the instructions provided with the card. You need only install the

hardware interface card, not the HP-IB Command Library or SICL software

that may be provided with the card. HP VEE provides the appropriate

SICL drivers, which are installed as part of the HP VEE installation. You

can install multiple HP-IB cards, and you can mix HP 82335 and HP 82341

cards in your system. However, if you are installing multiple HP-IB cards,

refer to Appendix A for information about select codes and I/O addressing.
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Installing HP VEE for Windows

N O T E

If you are installing HP 82335 HP-IB Cards, you must exclude address space for each card before you

install HP VEE. Also, you must assign a unique select code for each card. Refer to \Excluding Address

Space (HP 82335 HP-IB Card Only)" in Appendix A for further information. (You don't need to do this

for the HP 82341 HP-IB Card, nor for any of the National Instruments GPIB cards listed below.)

– National Instruments AT-GPIB, MC-GPIB, and GPIB-PCII/IIA cards. You

can install up to four GPIB (IEEE-488) cards, but they must all be of the

same type. Before you install HP VEE, install the GPIB card(s), and install

the GPIB driver software (for Windows) provided with the card.

N O T E

HP VEE for Windows does not currently support GPIO or MXI interfaces or devices.

HP VEE for Windows does not currently support direct access to a VXI backplane through embedded

VXI controllers. However, you can access VXI devices from HP VEE for Windows by using an

HP E1406 Command Module connected to one of the supported HP-IB or GPIB cards.

Once you have completed the installation, you can run the Instrument Finder utitity (refer

to \Finding Instruments" at the end of this chapter) to determine the select codes and addresses

of your serial, HP-IB, and GPIB devices. For complete information about I/O addressing, refer to

Appendix A.

HP VEE for Windows supports most printers supported by Microsoft

Windows, including:

– HP LaserJet Printers.

– HP DeskJet Printers.

– HP PaintJet Printers.
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Installation

Once you have set up your computer, and Microsoft Windows is installed,

you can install HP VEE for Windows. The installation program uses standard

Microsoft Windows keyboard and mouse techniques.

N O T E

Some anti-virus programs, including the one provided with MS-DOS 6.0, interfere with the installation

program. Before you begin the installation, disable any anti-virus program that is present following the

instructions provided with the program. Once you've installed HP VEE you can re-enable the anti-virus

program.

1. Start Microsoft Windows.

2. Insert \HP VEE for Windows Disk 1" in your Œoppy disk drive.

3. Pull down the File menu from the Program Manager window and select

Run.

4. Type the name of the Œoppy disk drive, followed by SETUP, and then press

ÄEnterÅ. For example, type: A:SETUP ÄEnterÅ. (It takes a few seconds for the

installation program to load and start.)

5. Answer the questions that the installation program asks. To do this, click

on the appropriate button on the screen (for example: OK or Yes), or type

in the requested information. (To click on a button on the screen, move

the mouse pointer over the button and press the left mouse button.)

a. The installation program asks you where you want to install the

HP VEE software (the default is C:\VEE), and where you want to store

the programs you create with HP VEE (the default is C:\VEE_USER).

The program then asks you to enter your name and the name of your

company.

b. The installation program asks you whether you want to Õll out and

print the product registration card. Just answer the questions and print
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Installation

out the card (assuming you already have a printer connected to your

PC). Or just Õll out the pre-printed card supplied with the product and

skip the electronic form.

c. The installation program asks you to insert disks 2 and 3 at the

appropriate times. Just click on OK once you've inserted each disk.

d. Once the Õles are installed, the installation program automatically

conÕgures your serial ports and any HP-IB cards found.

6. You'll be asked whether you want to install any instrument drivers at

this time. (If you click on No, you can install drivers later by using the

Install Drivers utility.) To install drivers now, click on Yes, insert

\HP VEE for Windows Drivers Disk 1" when prompted, and then click on

OK. A screen like the following one appears:

Use the scroll bar to search through the list, click on each driver that you

want to install (or click on Select All), and then click on Install.

Insert the driver disks as requested.
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Once you have Õnished installing drivers (or if you have skipped that step),

the HP VEE for Windows group window appears:

This group window contains six programs. To start HP VEE, double-click on

the HP VEE icon. The next chapter shows how to start and use HP VEE. You

can also start one of the Õve utility programs: Instrument Finder, Install

Drivers, Configure I/O, HP Driver Writer Tool, and HP ID Compiler.

These programs are described in the \HP VEE Utilities" appendix in HP VEE

Advanced Programming Techniques.

N O T E

The installation program automatically conÕgures any serial ports and HP-IB cards found. However,

if you change your I/O hardware (for example, if you add or remove an HP-IB card), you'll need to

reconÕgure. Just double-click on the Configure I/O icon to run the utility before starting your

next HP VEE session.

Your HP VEE for Windows installation is now complete. Before you start

HP VEE, run the Instrument Finder utility to determine your current I/O

conÕguration. Refer to \Finding Instruments" at the end of this chapter for

details.
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To Un-Install

If you want to \un-install" HP VEE for Windows, follow these steps:

1. Delete all the Õles (including subdirectories) in your installation directory

(default = C:\VEE) and your program directory (default = C:\VEE_USER),

and then remove the directories. Be sure to back up or make copies of

any programs in C:nVEE USER that you want to keep.

2. Delete the Õles (including subdirectories) in C:\SICL, and then remove

the directory.

3. Delete the Õles in C:\HPIDS and C:\HPIDS\HELP, and then remove the

directories.

4. Delete the VEEHELP.DLL, HPIB.DLL, SICL16.DLL, and SICLUT16.DLL

Õles from your windows directory (default = C:\WINDOWS). Then, remove

the [VEE], [SICL], and [HPIDS] sections from the WIN.INI Õle, also in

your windows directory.

5. Delete all of the icons in the HP VEE for Windows group window, and

then delete the group window.

To Re-Install

You can re-install HP VEE at any time without diœculty | you do not have to

un-install it Õrst. When you re-install HP VEE the V.INI Õle, which contains

your conÕguration information, is replaced. However, the old version of this

Õle is saved as VOLD.INI. To restore your old conÕguration, start an MS-DOS

window (or exit Windows) and execute the following MS-DOS commands:

CD C:\VEE

COPY VOLD.INI V.INI
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Finding Instruments

The Instrument Finder utility Õnds and reports the select codes of your

serial ports, HP-IB cards, and GPIB cards. The utility also Õnds and reports

the addresses of instruments connected to your HP-IB and GPIB cards. To run

the utility, double-click on the Instrument Finder icon in the HP VEE for

Windows group window. The Instrument Finder screen appears:

In this example, one HP 82335 HP-IB Card is reported at select code 7,

along with RS-232 serial ports COM1 and COM2 at select codes 9 and 10,

respectively. To Õnd individual HP-IB devices, click on More Info with the

HP-IB selection highlighted, as shown. To print your conÕguration, click on

Print. When you are ready to exit the utility, click on Close.

N O T E

If you have installed an HP 82335 HP-IB Card and it is not found, you probably haven't excluded

address space for it. Do this, following the instructions in Appendix A, run Configure I/O, and

then run Instrument Finder again to test the new conÕguration.
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Quick Start

HP VEE is HP's Visual Engineering Environment, an iconic programming

language for solving engineering problems. HP VEE gives you the ability

to gather, analyze, and display data without conventional (text-based)

programming. HP VEE increases your productivity by shortening the time it

takes to solve engineering problems.

This chapter takes you through some simple exercises to help you become

familiar with using the HP VEE iconic programming environment. Also, you'll

learn some key HP VEE concepts, and create some simple HP VEE programs.
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Interacting with HP VEE

In this section you'll learn how to work with the HP VEE iconic programming

environment | how to manipulate objects, create programs, save Õles, and

print the screen. The best way to use this manual is to follow along, doing

the exercises on your computer.

Of Mice and Menus

You're probably already familiar with the Microsoft Windows menu-driven

user interface | with pull-down menus and dialog boxes that you can control

with the mouse and keyboard. HP VEE for Windows uses this standard

user interface. If you're not familiar with using a mouse or operating in the

Windows environment, please refer to the \Windows Basics" chapter in the

Microsoft Windows User's Guide for information such as:

– Selecting and canceling menus.

– Choosing menu commands.

– Using the control menus.

– Working with dialog boxes.

– Working with windows.

– Using Windows online help.

Or, you may want to run the Microsoft Windows Tutorial, which shows you

how to use the mouse and how to work in the Windows environment. To run

the Tutorial, select Help from the Program Manager window and then click

on Windows Tutorial (see the following Õgure).
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Interacting with HP VEE

N O T E

Whenever we say to \click on" a menu selection, icon, button, or object, we mean to move the mouse

pointer to the appropriate location and quickly press and release the left mouse button. When we say

to \double-click," we mean to click the left mouse button twice in rapid succession. The right mouse

button is used less frequently, and only for special purposes. If you need to click the right mouse

button, we'll say so explicitly. If your mouse has a middle button, you won't need to use it for

HP VEE.
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Interacting with HP VEE

Starting HP VEE

To start HP VEE, double-click on the HP VEE icon in the HP VEE for Windows

group window (see the previous Õgure). It takes a few seconds for HP VEE to

load, and then a window like the following one appears:

In the Õgure above we've identiÕed the four major areas of the HP VEE

window:

– The title bar. This is the standard Microsoft Windows title bar, which gives

the name of the application. (You can move the window by dragging the

title bar.)

– The menu bar, which allows you to select menu items and features.

– The tool bar, which provides the Run, Stop, Cont, and Step buttons to

control HP VEE programs. The tool bar also displays the title of an HP VEE

program (default = Untitled).

– The work area, which is the space where you can create an HP VEE

program.

You can move or resize the HP VEE window by using standard Windows

techniques.
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Interacting with HP VEE

What If I Want to Quit? You can quit HP VEE at any time. Before you quit, you may want to save the

contents of your work area (refer to \To Save Your Program" later in this

chapter). Then exit HP VEE (refer to \Quitting HP VEE"). While doing the

exercises in this chapter, you can save your Õle and quit whenever you want

to take a break. You can then restart HP VEE, open your Õle (refer to \To

Open a File"), and pick up where you left oÃ.

Working with Objects

An HP VEE program consists of objects, which you place in the work area

and connect together to form an executable \block diagram." Let's begin by

learning to work with objects.

To Add Objects to the Work

Area

To add an object to the work area, you pull down the appropriate menu. For

example, to select the Function Generator object, click on Device in the

menu bar, and then click on Virtual Source in the Device menu. The

cascading menu of virtual sources appears, as shown in the following Õgure.
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Interacting with HP VEE

N O T E

From now on, we'll use a shorthand notation to indicate where to Õnd a menu selection. For example,

the location of the Function Generator object can be given as:

Device ¡¡) Virtual Source ¡¡) Function Generator

Now add the object to the work area by clicking on the Function Generator

menu item. An outline of the object appears in the work area. Move the

outline to where you want it and click the mouse button again. The object

appears as shown below:

Once you have placed an object in the work area, you can move it by

dragging its title bar, just as you would move a window.
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Interacting with HP VEE

To Change Object Views Every HP VEE object has two \views" | an open view and an icon | from

which you can choose. The two views of the Function Generator object

are shown below:

The Function Generator object, by default, appears in its open view. In

the open view all object parameters are visible, and you can edit them. Also,

the object menu button, title area, and minimize button are displayed at

the top of the object.

To change an object from its open view to its icon, click once on the minimize

button. You can use the icon to save space in your work area. To return to

the open view, double-click on the icon.
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Interacting with HP VEE

To Select the Object Menu Each HP VEE object has an object menu, which allows you to change the

size, position, title, and several other attributes of the object. Also, you can

get online help for the speciÕc object from the object menu.

To select the object menu, click once on the object menu button. The object

menu appears, as shown below. (Don't double-click on the object menu

button | you'll delete the object instead.)

Now you can click on one of the object menu choices to perform the action

you desire. Or, to make the object menu go away, click on an empty area

outside the menu.

Short Cut

You can also select the object menu as a pop-up menu by clicking the right mouse button with the

mouse pointer positioned anywhere over the object. This works for both the open view and the icon.
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Interacting with HP VEE

To Move an Object To move the Function Generator object, click on Move in the object menu

(select object menu ¡¡) Move), then click and hold the left mouse button. An

outline of the object appears. Just move the outline to the new location while

continuing to hold the mouse button down, as shown below:

Now release the mouse button | the object will jump to the new location.

Short Cut

You can move an open view object by grabbing and dragging its title area (the standard Microsoft

Windows method). You can also grab any part of the open view object except for buttons, entry

Õelds, pins, or terminals. You can move an icon by grabbing and dragging any part of it.
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Interacting with HP VEE

To Clone (Duplicate) an Object To clone the Function Generator object, click on Clone in the object menu.

An outline of the object appears, and you can move the outline to the desired

location:

Now click the mouse button and the cloned object appears, while the original

object remains.

To Delete an Object To delete an object from the work area, select object menu ¡¡) Cut for the

object you want to delete. For example, select the object menu for the

Function Generator on the right and click on Cut. The object disappears

from the work area, but it is saved in the \cut-and-paste" buÃer.

Short Cut

You can also delete an object by double-clicking on its object menu button. Be careful, this is easy to

do by accident.
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Interacting with HP VEE

To Change the Size of an

Object.

To change the size of an object, select object menu ¡¡) Size. The mouse

pointer becomes a \bottom-right-corner" bracket. Move this bracket to deÕne

the size that you want, as shown below:

When you click the mouse button again, the object is resized. (Note that this

procedure is diÃerent than that for resizing a window.)

Try resizing the object a few times on your own. You can enlarge the object

or reduce it as much as you want. However, if you reduce the object too

much, you may not be able to Õnd the object menu button. No problem.

Click the right mouse button with the mouse pointer over the object. The

object menu reappears, and you can resize the object.
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Interacting with HP VEE

To Change the Title of an

Object

To change the title, select object menu ¡¡) Change Title. The Change

Title dialog box appears:

To enter a new title, click on the edit area of the dialog box and start typing

| the old title disappears. Type Example Function Generator. When

you click on OK, the new title appears in the title area. If you minimize the

object, the new title appears in the icon.

Short Cut

You can save time by using standard Windows editing techniques. For example, if you click at the

extreme left edge of the edit area, the cursor will appear there. You can then type Example

without destroying the rest of the title.
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Interacting with HP VEE

To Clear the Work Area To clear all objects from the work area, use the standard Windows procedure:

select File ¡¡) New. Try it now. Just discard the changes in the work area

when prompted by the dialog box. (Click on No in response to Save Changes

First?.)

To Select the Edit Menu The Edit menu allows you to make changes involving several objects in the

work area. You can select the Edit menu in either of two ways. If you select

Edit from the menu bar, the Edit menu appears, as shown below:

Or, you can select the Edit menu as a pop-up menu by clicking the right

mouse button in any blank area of the work area.

In either case, click the left mouse button anywhere outside the menu to

make the menu go away.
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N O T E

The Edit menu selections Cut, Copy, Clone, Move Objects, Add to Panel,

and Create User Object remain inactive (\grayed out") until at least one object has been

selected. You'll see how this works in the next section. (The selections Edit User Function

and View Globals are also inactive unless User Functions or Global variables are present.)

To Cut and Paste Objects The Edit menu allows you to cut and paste objects in the work area. For

example, add a Formula object to the work area by selecting Math ¡¡)

Formula.

Now click on the object. The object's \shadow" appears, as shown below:

This shadow indicates that the Formula object is selected, and you can now

edit it. To cut the object, select Edit ¡¡) Cut. (Cut becomes active when

you select the object. It remains inactive, or \grayed out," until you select at

least one object.)
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Now paste the object back in the work area (Edit ¡¡) Paste). Move the

outline to the desired location and click the mouse to paste the Formula

object back in the work area. Once an object is in the cut-and-paste buÃer,

you can paste it as many times as you want.

N O T E

Whenever you cut an object (either from the Edit menu or from the object menu), the object is

deleted from the work area, but it is saved in the \cut-and-paste" buÃer. However, only the most

recently cut object is saved in this buÃer.

To Copy or Clone Objects You can either Copy or Clone objects by using the Edit menu. The Copy

selection just copies the selected object into the \cut-and-paste" buÃer. You

can then paste the object as if you had cut it. On the other hand, the Clone

selection clones the selected object directly, in one step.

Click on the Formula object to select it, and then select Edit ¡¡) Clone.

Move the object outline to a new location, as shown below:
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Click again and another Formula object appears in the outlined location.

To Select and Edit Multiple

Objects

Although the easiest way to select an object is to click on it with the mouse,

you can only select one object at a time that way. When you select a second

object, the Õrst is \unselected" and its shadow disappears.

To select multiple objects, select Edit ¡¡) Select Objects and then click

on each object you want to select. Each will become shadowed in turn. For

example, the two Formula objects, when selected, appear as follows:

Now click the left mouse button in an empty part of the work area. The

\Select desired objects" mode is turned oÃ, but the objects remain selected.

(However, if you click a second time, the objects become \unselected.")

You can use the Edit menu to move or copy the selected objects. For

example, you can clone the objects with Edit ¡¡) Clone. An outline deÕning

both selected objects will appear. Just move the outline to the desired

location, as shown in the following Õgure.
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Now click the mouse button again (at the desired location), and two more

Formula objects appear:

You can select any number of objects with Edit ¡¡) Select Objects. You

can then Cut and Paste the selected objects, or you can use Move Objects

to move them. To \unselect" the selected objects, just click on an empty area

in the work area. Try experimenting with these commands on your own.
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To Move the Work Area So far we've looked at a couple of ways to move individual objects, or to

move multiple objects. You can also move the entire work area. One way to

move the work area is to click on an empty area and drag the work area in

any desired direction. Another way to move the work area is to scroll it using

the scroll sliders and scroll arrows, which appear if one or more objects are

placed outside the visible work area.

For example, click on an empty area and drag the work area so that objects

are outside both the vertical and horizontal boundaries, as shown below:

When you release the mouse button, both sets of scroll sliders and scroll

arrows appear, as shown above:

– To move the work area up and down, drag the scroll slider in the right

margin of the HP VEE window.

– To move the work area left and right, drag the scroll slider in the bottom

margin of the HP VEE window.

– To move the work area in small steps, use the appropriate scroll arrow:

left, right, up, or down.
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Understanding Pins and Terminals

A single object can do little by itself. However, by connecting objects together

with lines, you can construct an HP VEE program. The points of connection

are the input and output pins. Most objects have one or more of the following

kinds of pins:

– Pins on the left-hand side of an object are data input pins.

– Pins on the right-hand side of an object are data output pins.

– The pin on the top of an object is the sequence input pin.

– The pin on the bottom of an object is the sequence output pin.

Some objects have all four kinds of pins, while others have only one or two

kinds of pins. In an object's open view, the data input and output pins can

be represented as input and output terminals, which display their terminal

labels. The terminal labels are visible only in the open view, and only if the

Show Terminals option (selectable from the object menu) is active.

Let's look at an example. Add a Formula object to the work area (Math ¡¡)

Formula). By default, the object shows its terminals, as shown below on the

left:
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If you turn oÃ Show Terminals (object menu ¡¡) Terminals ¡¡) Show

Terminals), the Formula object appears as shown on the right. Show

Terminals is a \toggle" feature. That is, each time you select it, it changes

state. If Show Terminals is active, a checkmark appears in front of it in the

object menu.

To Add a Terminal You can add a second data input terminal to the Formula object by using

the object menu (object menu ¡¡) Terminals ¡¡) Add Data Input). Or,

provided Show Terminals is active, you can simply place the mouse pointer

in the \terminal area" (the left margin of the open view object) and press

ÄCtrlÅ+ÄAÅ (press the ÄCtrlÅ and ÄAÅ keys simultaneously). In either case, a

second data input terminal, B, appears as shown below:

To Obtain Terminal

Information

The terminal label gives you some terminal information. For example, the B

data input terminal that you added is labeled B Any. The terminal name is

B and the required data type for the input terminal is Any, meaning any

HP VEE data type is allowed. To obtain more information, double-click on the

terminal label area. The following dialog box appears:
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You can now edit the terminal. For example, if you click on the Name entry

Õeld, you can change the name of the terminal. If you click on Any in the

Required Type Õeld, you can select another data type from a second dialog

box, shown below:

If you select a data type other than Any for a data input terminal, only the

speciÕed type of data, or data that can be converted to that type, will be

accepted by the terminal. For further information about data types and

shapes, refer to Using HP VEE.

To Delete a Terminal To delete a terminal, you can use the object menu:

Use object menu ¡¡) Terminals ¡¡) Delete Input to delete an input.

Use object menu ¡¡) Terminals ¡¡) Delete Output to delete an output.

Or, as a short cut, you can place the mouse pointer over the terminal you

want to delete and press ÄCtrlÅ+ÄDÅ. However, make sure that you place the

pointer over the terminal | otherwise, you may accidentally delete the object

itself. (ÄCtrlÅ+ÄDÅ is also the short cut for deleting an object.)
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Getting Help

HP VEE uses the standard Windows online help system. Click on Help and

the following menu appears:

Select How to Use Help for information on Windows Help. Or select

Contents to launch the help window:
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The help window is hypertext driven. Just click on the desired topic to move

through the help system. The major topics are listed in the Contents screen:

– On Features brings up a list of HP VEE features and objects. Click on the

name of the feature that you want to explore.

– Math Syntax brings up a list of HP VEE mathematical operators and

functions that you can use in the Formula object. Most of these operators

and functions are also available as individual objects that you can select

from the Math and AdvMath menus.

– How To brings up some topics that summarize how to use HP VEE.

– Keyboard Short Cuts brings up a list of keyboard accelerators.

– Examples brings up a list of example programs. You can select and open

an example directly from Help.

– Latest Information brings up the latest information on the current

HP VEE release.

– Glossary brings up a list of terms with pop-up deÕnitions.

For help on a particular object, you can click on Help in the object menu for

that object. This takes you directly to the appropriate help topic.

To quit help and close the help window, select File ¡¡) Exit for the help

window, not for the HP VEE window.

Quitting HP VEE

You can quit HP VEE by selecting File ¡¡) Exit. However, if a program is

running, you'll have to stop it Õrst (refer to \To Run Your Program" later in

this chapter). Also, if you haven't saved your most recent changes to a Õle, a

dialog box asks you if you want to save your changes. Select No, clear to

discard your changes, or Yes, save to save them to a Õle (refer to \To Save

Your Program" later in this chapter).
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Now that you've learned to work with objects and the HP VEE user interface,

let's look at how to use objects to create HP VEE programs. We'll also discuss

how HP VEE iconic programs work.

Your First Program

In this section you'll create a simple HP VEE program, print the HP VEE

screen, and save your program to a Õle.

To Create a Simple Program Fundamentally, an HP VEE program consists of HP VEE objects connected

together to form an executable \block diagram." Let's create a very simple

program that displays a waveform. If you've quit HP VEE, restart it. If

HP VEE is already running, clear the work area by selecting File ¡¡) New.

Now add the Function Generator object (Device ¡¡) Virtual Source

¡¡) Function Generator) and the Waveform (Time) object (Display ¡¡)

Waveform (Time)) to the work area, as shown in the following Õgure.
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Now you can complete the program by connecting the data output pin on

the Function Generator to the data input pin on the Waveform (Time)

display. Click the left mouse button just outside of one of the pins. (Don't

click on the pin itself, or inside the object | you'll end up moving the

object.) Now move the mouse pointer to the other pin, and click again. A

line is automatically routed between the two pins, and your program is

complete.

Try moving one of the objects. (Don't grab a pin or terminal | you'll get

strange results if you do.) Note that the line is automatically rerouted to the

most logical path between the two objects. This auto-line routing feature

saves you lots of time when you build a large program.

N O T E

Occasionally you may want to use Edit ¡¡) Clean Up Lines to reroute all of the lines in

your program.
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You can add a title for your program. Just select File ¡¡) Change Title and

change Untitled to Simple Program in the dialog box.

To Run Your Program To run your program, click on the Run button in the tool bar. The program

displays a 1000 Hz cosine wave in the Waveform (Time) display, as shown

below:

In addition to the Run button, you can use the Stop, Cont, and Step

buttons to control the program. Once you have stopped a running program,

you can use Cont to continue it. Or you can use Step to run a program

one-step-at-a-time.

N O T E

From now on, when we say to \run" your program, just click on the Run button in the tool bar.
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To Change Object Parameters You can change the parameters of an object in its open view. You may

have noticed that the Function Generator object has \raised" Õelds. For

example, Cosine is raised in the Function Õeld. Such raised Õelds are

buttons, which you can \press" by clicking on them. If you click on Cosine,

the Select Function dialog box appears:

To select the sine function, click on Sine, and then click on OK. (Or just

double-click on Sine.)
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Other Õelds are \recessed" (for example, the Frequency Õeld). These are

entry Õelds, which become \type-in" Õelds when you click on them. Just

click on the Õeld and a cursor will appear. You can use standard keyboard

editing techniques to move the cursor and enter the desired value. Or you

can use standard Windows mouse techniques to select and modify text within

the Õeld.

For example, click on the Frequency Õeld to the right of the value 1000

and, while holding the mouse button down, move the mouse to the left to

highlight the last 0, then release the mouse button:
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Now, press ÄDeleteÅ to delete the last 0, changing the Frequency value to 100.

Run the program (click on Run) and you should get the following result:

The displayed waveform is now a 100 Hz sine wave.

Try changing a few object parameters on your own:

1. Click on Deg in the Function Generator object and change the phase

units to Rad. Now click on the Phase value Õeld and enter the value PI.

Click on Run and note the phase shift in the displayed waveform. Now

change the Phase value back to 0 and the units back to Deg.

2. The y-axis limits of the Waveform (Time) object are preset to -1 through

1. Click on each value Õeld and change the limits to -2 through 2.

You'll see the waveform displayed within the new limits. Now click on

Auto Scale and the waveform will be automatically scaled back to -1

through 1.
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To Print the Screen To print the screen, select File ¡¡) Print Screen. The following dialog box

appears:

When you click on OK, HP VEE prints the screen on the Windows default

printer (LPT1 in this example). You can change the print range, the print

quality, or the number of copies before you print.

When you click on Setup, the Windows Print Setup dialog box appears,

from which you can access any printer you have set up in Windows.

You can select a printer (select Specific Printer, click on the down arrow,

and then click on the desired printer), change the orientation (Portrait or
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Landscape), and select the paper size and source. Click on OK to return to

the Print dialog box, and then click on OK to print the screen.

For further information about using dialog boxes, refer to the Microsoft

Windows Tutorial.

To Save Your Program You can save your program (whatever is in the work area, whether complete

or not) at any time. To save the program select File ¡¡) Save As and the

Save File dialog box appears, as shown below:

By default, HP VEE saves your Õles to the vee_user directory. To save

the current program, just click on the File Name Õeld and type in a name

(for example, simp-prg) and click on OK. HP VEE automatically adds the

extension .vee to the Õle name.

N O T E

HP VEE for Windows Õle names must follow the MS-DOS Õle name conventions. Up to eight

characters are allowed, followed by a period and an extension of up to three characters. Alpha

characters are case insensitive | they are \case-folded" into upper-case characters.
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You can re-save your program to the same Õle name at any time by selecting

File ¡¡) Save. It is a good idea to save your Õle frequently while you

are developing a program. If you want to save your changed program to a

diÃerent Õle name, select File ¡¡) Save As instead.

To Open a File You can open a program Õle by selecting File ¡¡) Open. The Open File

dialog box is essentially the same as the Save File dialog box, but you'll be

given a list of available Õles from which to choose. Just click on the desired

Õle name (or type in the name in the File Name Õeld), and then click on OK

to open the Õle.

How HP VEE Programs Work

In conventional programming languages such as C, BASIC, or Pascal, the

order in which program statements execute is determined by a set of

sequence and selection rules. Generally, statements execute in the order they

appear in the program, except where statements cause execution to branch to

another statement or section of code.

In HP VEE the general Œow of execution through a program is called

propagation. Propagation through a program is not determined by the

geographic locations of the objects in the program, but rather by the way the

objects are connected. Propagation is primarily determined by data Œow,

which is determined by how the data input and output pins of the objects are

connected. Here are the rules of data Œow:

– Data Œows from left to right through an object. This means that on all

objects with data pins, the left data pins are inputs and the right data pins

are outputs.

– All of an object's data input pins must be connected. Otherwise an error

will occur when the program is run.

– An object will not execute until all of its data input pins have received

data.

– An object Õnishes executing only after all appropriate data output pins

have been activated.
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In HP VEE you can change the order of execution by using sequence input

and output pins. However, you won't normally need to use sequence pins,

except to ensure the order of execution when controlling external devices

such as instruments. For internal HP VEE operations, it is generally best to

avoid using the sequence pins. If possible, let data Œow control the execution

of your program.

To see how data Œow works, let's take another look at the program you

created earlier. Open the program (simp-prg.vee) that you saved in the

previous section (select File ¡¡) Open) and run it. It should appear as

follows:

Note that the data output pin of the Function Generator object is

connected to the data input pin of the Waveform (Time) object. When you

run the program, the Waveform (Time) object won't execute until it receives

data from the Function Generator object. This is a simple example of data

Œow.
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Now let's create a \noisy sine wave" by adding a Noise Generator object to

our program, as shown below:

To create this program you'll Õrst need to delete the line connecting the

Function Generator and Waveform (Time) objects in the original program.

You can use the Edit menu to do this: click on Edit ¡¡) Delete Line, and

then click on the line. Or you can use a shortcut: press and hold ÄShiftÅ+ÄCtrlÅ,

and then click on the line.

Now minimize the Function Generator to its icon, and add the Noise

Generator (Device ¡¡) Virtual Source ¡¡) Noise Generator) and +

(Math ¡¡) +-*/ ¡¡) +) objects. Connect the input and output pins as shown

in the Õgure.

What is the order of execution? The Waveform (Time) object won't execute

until it has received data from the + object. The + object won't execute until

both of its inputs have been satisÕed by the Function Generator and Noise

Generator objects. This leaves the question of which executes Õrst, the

Function Generator object or the Noise Generator object? The answer

is that it doesn't matter. In either case, the result is the same. The + object

doesn't execute until both generator objects execute. Once both of its inputs

receive data, the + object executes, summing the two signals and outputting

the result to the Waveform (Time) object. Thus, the program operates just

Õne, execution being determined solely by data Œow.
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To see the order of execution, turn on Show Exec Flow and Show Data Flow

by selecting each of these in the Edit menu. These \show Œow" features are

\toggles" | a checkmark in the menu indicates that the feature is active.

Now run the program. Each object is highlighted when it executes, and data

Œow is shown by \torpedoes" that move down the lines. (These \show Œow"

features do slow down program execution, so normally you'll want to turn

them oÃ.)

Now let's add an Amplitude input for the Noise Generator. You can

use the object menu, or just press ÄCtrlÅ+ÄAÅ with the mouse pointer in the

\terminal area" at the left side of the Noise Generator. A dialog box asks

you to select an input to add:

Select Amplitude by clicking on OK | an Amplitude input terminal appears.

Now add a Real Slider object (Data ¡¡) Real Slider) and connect its data

output pin to the Amplitude terminal, as shown in the following Õgure:
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Try changing the amplitude of the noise (drag the \knob" on the Real

Slider object). The amplitude of the noise doesn't change until you run the

program, and then the noise component of the displayed waveform depends

on the Real Slider output value.

Again, data Œow determines the order of execution. The Noise Generator

can't execute until the Real Slider executes. The + object can't execute

until both the Function Generator and the Noise Generator have

executed, but it doesn't matter which one executes Õrst. Finally, the

Waveform (Time) object executes only after the + object has executed.

Save your program again (to simp-prg.vee). You'll add some more features

to it in the next chapter.
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Some HP VEE Programming Techniques

In the previous chapter you learned how to interact with HP VEE and create

a simple HP VEE program. In this chapter, you'll learn some selected HP VEE

programming techniques that you may Õnd useful in building your own

programs.

3-2



General Techniques

This section provides some general HP VEE programming techniques that

include working with data, creating User Objects, and creating a user

interface.

Creating a UserObject

A UserObject is an object that you can create by collecting a logical grouping

of objects into one custom object. A UserObject has a work area, similar

to the work area of the main HP VEE window. You can place and connect

various objects (including other \nested" UserObjects) within the work area

of a UserObject. You can also deÕne the appropriate input and output pins

for your UserObject. In brief, a UserObject is a separate context from the

context of the main program (the main work area). You can use a logical

grouping of objects to create a UserObject that performs a useful purpose

within your main program. This not only conserves \real estate" in your

main work area | it makes your program more readable.

One way to create a UserObject is to select Device ¡¡) UserObject from the

menu bar and place a blank UserObject in the work area:
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Now you can add objects to the UserObject work area, add the appropriate

input and output pins, and connect the pins to other objects in the main

program.

Note that the UserObject has an object menu button and minimize button,

like any HP VEE object. In addition, it has a maximize button. If you need

a larger work area within the UserObject, you can resize it from the object

menu, or you can click on the maximize button to make the UserObject

take up the entire HP VEE work area. You can move the work area of the

UserObject just as you would the main work area.

Another way to create a UserObject is to select objects within a program,

and then create a UserObject from them. Let's use the program you created

in the last chapter as an example. Open the program that you created

(simp-prg.vee), minimize the Noise Generator object, and rearrange the

objects as shown in the Õgure below:

Now select the Noise Generator and + objects. To do this, turn on \Select

desired objects" by clicking on Edit ¡¡) Select Objects (or use the

shortcut ÄCtrlÅ+left mouse button). Click on the objects to select, and then

move the mouse pointer to an empty area and click again to turn oÃ \Select

desired objects."
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To create the UserObject from the selected objects, click on Edit ¡¡) Create

UserObject. The UserObject will contain the Noise Generator and +

objects, and will automatically be created with the appropriate input and

output pins and connections:

N O T E

The reason for rearranging the positions of the objects before executing Create UserObject

is one of convenience. If you don't collect the objects to be included into one area, the UserObject will

be rather large and convoluted. You can rearrange and resize the work area of the UserObject, and

move the UserObject to an appropriate place in the work area after the fact. But the cleanup is easier

if you place the objects logically beforehand.

You can use Edit ¡¡) Clean Up Lines to clean up the line routing within your program.

However, Clean Up Lines is context dependent. You'll have to run it once for the main

program and once within the UserObject.
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You can save screen space in your program, and make it easier to read

visually, by minimizing a UserObject. But it is a good idea to add a title to

the UserObject Õrst. Change the title from UserObject to AddNoise (object

menu ¡¡) Change Title). While you are at it, change the title of the Real

Slider to Noise Amplitude. Note how this makes the logic of the program

easier to follow:

The key to the proper use of UserObjects is to make sure that the UserObject

has a logical purpose within the program. Thus, the UserObject is not

just a space saving device, but rather a way of structuring your program.

UserObjects help you use \top-down" design in your HP VEE programs. For

further information on UserObjects, refer to Using HP VEE.

We'll continue with this example in the following section, so if you want to

quit now, save your program (simp-prg.vee).
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Creating an Operator Interface

HP VEE makes it easy to create an operator interface for your program. All

you need to do is create a panel view. Let's continue with our previous

example to see how this is done:

1. Open your program (simp-prg.vee) if it is not already in the work area.

2. Select the Real Slider and XY Trace objects (use Edit ¡¡) Select

Objects).

3. Add the selected objects to the panel (use Edit ¡¡) Add To Panel). A

panel view appears, showing the two objects that you added to the panel.

You can move the objects in the panel view to appropriate locations to create

a panel similar to the one shown below:

Note that two buttons appear in the tool bar: Panel and Detail. Try

pressing Detail to go to the detail view, and then Panel to return to the

Panel view. The detail view is the normal HP VEE work area, from which

you would typically edit your program. (For example, if you want to change
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the title of the program, you'll have to do it from the detail view.) On the

other hand, you can edit the panel view separately. For example, you can

move, resize, or delete objects in the panel view independently from the

detail view. Thus, you can organize the panel view as an operator interface

for your program.

Again, save your program (simp-prg.vee) if you want to quit now. We'll use

it again in the next section.

Using Data Files

You can easily write data from HP VEE in a data Õle, and read the data back

into HP VEE, by including the To File and From File objects in your

program. As an example, let's add a To File object to the detail view of the

program you've been building.

Open the program (simp-prg.vee), if it isn't already in your work area, and

go to the detail view. Now add a To File object to the work area (I/O ¡¡)

To ¡¡) File):

Now change the name of the data Õle (the To File Õeld) to wavedata. Just

click on myfile, and the following dialog box appears:

3-8



Some HP VEE Programming Techniques

General Techniques

Double-click in the edit Õeld to select myfile, type in the new name, and

then click on OK. Also, click on the checkbox in the To File object to activate

Clear File at PreRun and Open, as indicated by the checkmark in the

following Õgure:

Now click on the write transaction labeled WRITE TEXT a EOL, as indicated

by the mouse pointer (arrow) in the above Õgure. The I/O Transaction

dialog box appears as follows.
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Click on TEXT and you'll be given a list of data types to write. Click on

CONTAINER, and then on OK to change the transaction to WRITE CONTAINER

a. Connect the data output pin of the AddNoise UserObject to the data input

pin of the To File object, as shown in the following Õgure.

Now the program not only displays the noisy sine wave output by the

AddNoise UserObject, but also writes a container of waveform data to the Õle

wavedata.
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N O T E

For further information about I/O transactions, refer to HP VEE Advanced Programming Techniques. For

further information about containers, refer to Using HP VEE.

Let's add a From File object to the program to read the data back. You'll

need to change the read transaction to READ CONTAINER x (the procedure is

the same as for To File). Now delete the line between AddNoise and the

Waveform (Time) object, and connect the objects as shown:

Note that when the To File object Õnishes executing (after it has written

to the Õle wavedata) it activates the sequence input pin on the From File

object, which reads the container of data and outputs the waveform to the

display object.
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Try clicking on the Panel button. You'll Õnd that the panel view has not

been changed by any of the changes to the detail view.

Mathematically Processing Data

HP VEE provides extensive mathematical capabilities, which are documented

in the HP VEE Reference manual and in HP VEE Help. Let's take a quick look

at some of these capabilities.

To Use Data Types HP VEE supports several data types, including text, integer and real numbers,

and several types of complex and coordinate numbers. For a complete

discussion of data types, refer to Using HP VEE. You have already seen how

the + object can add two waveforms together in our earlier examples. In fact,

the mathematical operators such as + can act on several data types, and can

even act on mixed types of data. Let's look at an example:

To create the following program, clear the work area, place the following

objects in the work area, and connect them as shown:

– Real Constant object:

Select Data ¡¡) Constant ¡¡) Real.

– Complex Constant object:

Select Data ¡¡) Constant ¡¡) Complex.

– + object:

Select Math ¡¡) +-*/ ¡¡) +.

– AlphaNumeric object:

Select Display ¡¡) AlphaNumeric.

Now type the value 1.53 in the data entry Õeld of the Real object, and the

complex value (2,1) in the Complex object. Run the program and you

should get the following result:
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HP VEE automatically converts the data as needed, then performs the

addition in the + object. The real value 1.53 is converted to the complex

value (1.53,0), which is then added to the complex value (2,1). The

result, (3.53,1) (a complex number), is displayed in the Alphanumeric

object.

Normally, HP VEE takes care of all data type conversions for you. You won't

need to do anything special, but you should be familiar with the conversion

rules that HP VEE follows. Refer to Using HP VEE for further information.

To Use Data Shapes HP VEE supports a variety of data shapes, such as scalars and arrays. Unlike

most programming languages, HP VEE objects can operate on an entire array,

rather than on only one element.

The following program creates a one-dimensional, ten-element array,

calculates the median of the 10 values, and then displays the median value.

To create the program, clear the work area, place the following objects in the

work area, and connect them as shown:

– For Range object:

Select Flow ¡¡) Repeat ¡¡) For Range.

– Sliding Collector object:

Select Data ¡¡) Sliding Collector.

– median(x) object:

Select AdvMath ¡¡) Statistics ¡¡) median(x).

– AlphaNumeric object:

Select Display ¡¡) AlphaNumeric.
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When you run the program, the For Range object repeats 10 times,

outputting the following series of real scalar values: 0, 1, 2, 3, 4, 5, 6, 7, 8,

9. The Sliding Collector creates a 10 element array from these values.

To see this, double-click on the input and output terminals for the Sliding

Collector. When you double-click on the Data input terminal, the Input

Terminal Information dialog box should show that the last value input

was the real scalar value 9. When you double-click on the Array output

terminal, the Output Terminal Information dialog box should show that

the output data is a one-dimensional, ten-element array. The median(x)

object calculates the median value for the array, which is displayed by the

AlphaNumeric object.

You can use Show Exec Flow and Show Data Flow to see how the program

executes.

To Use the Formula Object HP VEE provides numerous mathematical operators and functions, all of

which are documented in the HP VEE Reference manual and under Math

Syntax in HP VEE Help. Most of these features are available as individual

objects under the Math and AdvMath menus. However, you can create any

valid HP VEE mathematical expression within the Formula object, which is

found under the Math menu.

Let's look at an example that shows the use of the Formula object. To create

the program, clear the work area and follow these steps:

1. Add the Function Generator object to the work area and modify it to

produce a 100 Hz sine wave.

2. Add the Formula object to the work area. Add a second input (B) to it

(move the mouse pointer to the input terminal area and press ÄCtrlÅ+ÄAÅ).

Now type the mathematical expression abs(A)+B in the entry Õeld.

3. Add the Real constant object (Data ¡¡) Constant ¡¡) Real), and type in

the value 0.5.
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4. Add the Waveform (Time) display object and set the Y-axis scale to -2

through 2.

5. Connect the program as shown below:

When you run the program, the Formula object takes the waveform input

A and the real value B, and adds B to the absolute value of A. In eÃect, the

expression abs(A)+B \rectiÕes" the sine wave and adds a \dc oÃset." You

could have produced the same eÃect by using the + and abs(x) objects, but

it is easier to read an expression in a Formula object. (This saves space too.)

Try double-clicking on the input and output terminals of the Formula

object. Note that input A is a real array and input B is a real scalar. HP VEE

automatically adds scalar B to each element of array A.
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HP VEE for Windows provides extensive capabilities to communicate with

and control test instruments. There are three kinds of instrument I/O objects:

– An instrument panel provides a \front panel" to control a particular

instrument. When you change parameters in the HP VEE instrument

panel, the corresponding state of the instrument is changed. Instrument

panel objects require that you install the appropriate instrument driver Õle

before starting HP VEE (refer to Chapter 1).

– A component driver provides similar capabilities to those of an instrument

panel, but without the \front panel," and without direct control over the

state of the instrument. These objects also require that you install the

appropriate instrument driver Õle.

– A Direct I/O object provides a means of direct communication with an

instrument without the use of an instrument driver Õle.

This section introduces the use of instrument panels. For a complete

discussion of instrument panels, component drivers, Direct I/O objects,

and the HP Driver Writer Tool, refer to HP VEE Advanced Programming

Techniques.

ConÕguring Instruments

Let's begin by conÕguring an instrument. In this example you'll conÕgure

an instrument panel for an HP 3325B Function Generator. You probably

don't have one hooked up, but don't worry. One of the powerful features of

HP VEE instrument I/O is that you can conÕgure an instrument panel and

create a program with Live Mode OFF, which means that the instrument

doesn't have to be connected to your computer. Or the instrument can be

connected, but in Live Mode OFF HP VEE won't communicate with it. This

allows you to test much of your program before actually connecting and

communicating with the instrument.
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To conÕgure the HP 3325B instrument panel, clear the work area and follow

these steps:

1. Select I/O ¡¡) Instrument. The Instrument Select or Configure

dialog box appears. By default, the selections fgen, dvm, scope, and

serial are present. Please don't delete these. They are used in various

examples.

2. The Instrument Panel button (in the Instrument Type section) should

already be selected. If not, click on it. Now click on Add Instrument.

The Device Configuration dialog box should appear:

You'll edit the Õelds in this dialog box to add a function generator to your

list of instrument drivers. However, when changing values, do not press

ÄEnterÅ. If you do, you'll exit the dialog box. Instead, when you have edited

a Õeld, click on the next Õeld you want to edit, or use the ÄTabÅ key or

arrow keys to advance through the Õelds.

3. Click on the Name Õeld and type Func-Gen (remember, don't press ÄEnterÅ).

Now click on the Address Õeld and enter the address of your instrument.

Typically, the address for the HP 3325B is 717.
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N O T E

You can use the Instrument Finder utility described in Chapter 1 to Õnd the addresses of

your instruments. For detailed information on instrument I/O addressing, refer to Appendix A.

4. Click on the Instrument Driver Config . . . button. The following

dialog box appears. Note that the Live Mode Õeld in the Device

Configuration dialog box changes to ON at this point because you

entered a non-zero address:

5. Click on the ID Filename Õeld to select an ID (Instrument Driver) Õle. In

the list that appears, click on hp3325b.cid, and then click on OK.

6. Now click on OK in the Instrument Driver Configuration dialog box

to return to the Device Configuration dialog box. Click on the Live

Mode Õeld to change it back to OFF, and then click on OK to return to the

Instrument Select or Configure dialog box.
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Note that the new selection Func-Gen (HP3325B @ (NOT LIVE)) has

appeared in the list of instruments that you can select.

7. Now click on the Save Config button at the bottom of the dialog box.

The dialog box disappears and your new instrument conÕguration has

been saved.

Your Func-Gen conÕguration is now complete, and the conÕguration will be

available whenever you start HP VEE. Now let's try using this conÕguration.

Using an Instrument Panel

The open view of an HP VEE instrument panel object represents the front

panel of your physical instrument. Just as you can change the settings

on your physical instrument's panel, you can change the settings on the

instrument panel object in HP VEE. If your instrument is connected and live

mode is ON, any valid changes you make on the HP VEE instrument panel
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will control the physical instrument, just as if you made the changes on that

instrument's front panel.

Let's continue with our example:

1. Select I/O ¡¡) Instrument again. The Instrument Select or

Configure dialog box appears. Click on Func-Gen (HP3325B @ (NOT

LIVE)) once to highlight the selection, and then click on it again (or click

on the Get Instr button). An outline of the Func-Gen instrument panel

object appears in the work area. Place the outline where you want it, and

click the mouse button to add the object to the work area:

2. Click on Sine. A dialog box gives you a series of choices for the

Function Õeld. Double-click on Square to change the shape of the

waveform. If a function generator was connected, and live mode was ON,

this change would also occur on the physical instrument.

3. Click on the Main Panel Õeld. A dialog box lists the panels for this

particular instrument. Each panel allows you to change various instrument

parameters.

4. Go to another panel, such as the Sweep or Modulation panel. To do this,

either double-click on the panel name, or click on the panel name and then

click on OK.

The panel you selected appears in place of the main panel. By using the

various panels, you can interactively access and control the features of the

instrument.

5. Return to the main panel by clicking on the panel Õeld and selecting Main

Panel again.
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Using an Instrument Panel in a Program

Let's create a program that uses the Func-Gen object to control the

frequency of the function generator in a step-wise fashion. To do this, follow

these steps:

1. Add a Frequency data input terminal to the Func-Gen object. To do

this, place the mouse pointer over the input terminal area in the left

margin of the object and press ÄCtrlÅ+ÄAÅ. A dialog box lists the possible

input terminals that you can add. Double-click on Frequency to add that

terminal.

2. Add a For Range object (Flow ¡¡) Repeat ¡¡) For Range). Change the

parameters as follows: From = 10k, Thru = 100k, and Step = 10k. (You

can type either 10k or 10000.)

3. Add a Delay object (Flow ¡¡) Delay). Click on the recessed Õeld and

enter a value of 1 for the delay in seconds.

4. Connect the objects as shown below:

When you run the program, the For Range object steps the function

generator through frequencies of 10 kHz, 20 kHz, and so forth, up to 100 kHz.

Because of the delay object, each step takes 1 second.
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If you have an HP 3325B Function Generator connected to your computer,

you can now turn live mode ON and control your real instrument. To do this,

select I/O ¡¡) Instrument, and then select Func-Gen (HP3325B @(NOT

LIVE)). Click on Edit Instrument. Change Live Mode to ON in the Device

Configuration dialog box. Click on OK and then Save Config to save the

new conÕguration. Now try the program again and watch the front panel of

your physical instrument. For further information, refer to Using HP VEE.

Getting Instrument Help

You can get online help for any instrument for which you have installed

an instrument driver (refer to Chapter 1). When you install a driver, the

program also installs a help Õle for the driver. To get help, select Help ¡¡)

Instruments . . . and then select the help Õle (for example, hp3325b.ih)

for your instrument from the list.

Unlike the other HP VEE help topics, the instrument driver help Õles do not

use the Windows Help system. The following is an example of help for the

HP 3325B Function Generator:
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HP VEE provides a great number of program examples that demonstrate

various HP VEE programming techniques. You'll not only Õnd these examples

to be good learning tools, but you may be able to incorporate portions of

these examples in your own programs.

The example Õles are found in the subdirectories under c:\vee\examples.

However, you can open example Õles directly from HP VEE Help. To do

this, select Examples from the help Contents screen. A scrollable list of

examples appears:

Now click on the hypertext link for the example you want. For example,

when you click on beam, the following screen appears:
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To open the beam program, click on the Open button. If you have a program

in the work area, you'll be prompted to save it or discard changes. Once the

example is loaded, just click on Run to start the program.
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What's Next?

Now that you've Õnished our short introduction to HP VEE's capabilities, you

can try some things on your own. You can Õnd information in the following

places:

– Using HP VEE provides detailed information about the basic HP VEE

programming techniques. Several example programs, included with

HP VEE, are described.

– HP VEE Advanced Programming Techniques provides detailed information

about the advanced features of HP VEE. Examples of advanced HP VEE

programs are described.

– HP VEE Reference provides reference sections for all of the HP VEE

features. These reference sections are also provided in HP VEE Help.
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I/O Addressing

HP VEE for Windows supports RS-232 serial, HP-IB, and GPIB interfaces.

(HP-IB is Hewlett-Packard's implementation of the IEEE-488 interface bus

standard. Other implementations are commonly called GPIB.) Also, you can

access VXI devices by using an HP E1406 Command Module connected to one

of the supported HP-IB or GPIB interfaces. For information about the speciÕc

interfaces supported, refer to Chapter 1.

To access an I/O device, determine the correct address and enter it in the

Address Õeld in the Device Configuration dialog box.

N O T E

For information on addressing instruments using dialog boxes, refer to \ConÕguring Instruments"

in Chapter 3 of this manual. For information on Õnding instrument addresses, refer to \Finding

Instruments" in Chapter 1 of this manual. For detailed information on instrument I/O, refer to the HP

VEE Advanced Programming Techniques manual.
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The addressing schemes for various types of devices are described in the

following sections.

To Address Serial Ports

The four PC serial ports are supported by using select codes 9 { 12:

Select Code Interface

9 (default) COM1 serial port

10 COM2 serial port

11 COM3 serial port

12 COM4 serial port

To Address HP-IB and GPIB Interfaces and Devices

HP-IB and GPIB devices are addressed using the following scheme:

SPA[SA]

Where:

S is the select code of the HP-IB or GPIB interface.

PA is the primary address of an HP-IB or GPIB device (the valid

range is 00 through 31).

SA is the optional secondary address (the valid range is 00

through 31).
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Let's look at a couple of examples to see how this works:

– For an HP-IB device at select code 7, primary address 01, enter 701 in the

Address Õeld of the Device Configuration dialog box.

– For a GPIB device at select code 14, primary address 09, secondary address

02, enter 140902 in the Address Õeld of the Device Configuration

dialog box.

HP-IB Select Codes The select codes for HP-IB interfaces are as follows:

Select Code Interface

1
*

HP 82341 HP-IB Card

2
*

HP 82341 HP-IB Card

3 HP 82341 or HP 82335 HP-IB Card

4 HP 82341 or HP 82335 HP-IB Card

5 HP 82341 or HP 82335 HP-IB Card

6 HP 82341 or HP 82335 HP-IB Card

7 (default) HP 82341 or HP 82335 HP-IB Card

8
*

HP 82341 HP-IB Card

* Select codes 1, 2, and 8 are not recommended for the HP 82335 HP-IB Card.

Theoretically, you can have up to eight HP-IB cards in your system, which

can be a mix of HP 82335 and HP 82341 cards:

– For an HP 82335 HP-IB Card, the select code is determined by switch

settings on the card (the default is 7). If you install more than one HP

82335 card, each card must be set for a unique select code in the range 3

through 7. (Refer to your HP-IB card installation manual for instructions.)

Also, you must exclude address space for each card. Refer to \Excluding

Address Space (HP 82335 HP-IB Card Only)" later in this appendix.

– For an HP 82341 HP-IB Card, the select code is assigned by the software.

The select codes are assigned in the order: 7, 8, 1, 2, 3, 4, 5, and 6.

GPIB Select Codes The National Instruments GPIB driver conÕgures up to four GPIB cards (all

must be of the same type) with the designations GPIB0, GPIB1, GPIB2, and

GPIB3. HP VEE assigns select codes to these cards as follows:
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Select Code Interface

14 GPIB0

15 GPIB1

16 (Reserved)

17 GPIB2

18 GPIB3

To Address VXI Devices on the HP-IB or GPIB

Secondary addresses are commonly used to address VXI card cages through

the HP-IB or GPIB. If you are using an HP E1406 Command Module in a VXI

card cage, the primary address is set by a switch on the command module

(default=09) and the secondary address is the individual VXI device's logical

address divided by eight.

For example, assume you have an HP E1406A Command Module

(address=09) in an HP E1401A C-Size High-Power Mainframe connected to

the HP-IB at select code 7. If you have an HP E1326B Multimeter in a VXI

slot, with its logical address set to 24, you would enter the value 70903 for

the address.

The hpe1300a.cid and hpe140x.cid instrument drivers can help you Õnd

the correct address (and sub address for a switch box).

N O T E

Do not enter a sub address value for VXI devices, except for modules in a VXI switch box. Refer to

the next section for details.
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To Set Address/Sub Address Values

Most HP-IB, GPIB, and VXI devices do not use sub addresses. Do not enter a

value in the Sub Address Õeld of the Instrument Driver Configuration

dialog box unless you are accessing a VXI switch box, or one of the card cage

devices that uses sub addresses (for example, the HP 3235A Switch/Test Unit

or the HP 3488A Switch/Control Unit).

N O T E

Sub address values are used only if you are using an HP Instrument Driver for a device that supports

sub addresses. Do not use sub address values if you are using Direct I/O.

Let's look at a couple of examples:

– If you are accessing a module in an HP 3235A Switch/Test Unit, enter

the HP-IB or GPIB address of the 3235A itself in the Address Õeld of

the Device Configuration dialog box (for example, 701). Enter the

sub address of the individual module in the Sub Address Õeld of the

Instrument Driver Configuration dialog box. For information on what

to put in the Sub Address Õeld, refer to the online help for the HP 3235A

instrument driver (Help ¡¡) Instruments).

– If you are accessing a module in a VXI switch box, enter the HP-IB or GPIB

address of the switch box (for example, 70902) in the Address Õeld, and

the sub address of the individual module in the Sub Address Õeld. For

information on what to put in the Sub Address Õeld, refer to the online

help for the VXI switch box instrument driver.
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Only)

If you are using an HP 82335 HP-IB Card, which uses memory-mapped I/O

addressing, you must exclude the address space required by the HP-IB so that

memory manager programs won't try to use that space. The HP 82341 HP-IB

Card and the National Instruments GPIB cards do not use memory-mapped

I/O addressing, so this section does not apply to those cards.

Install the HP 82335 HP-IB Card, following the instructions that came with it.

The HP 82335 is pre-set at the factory for select code 7, but the instructions

tell you how to change this setting. Normally you should use select code 7.

However, if you are using more than one HP 82335 HP-IB card, each card

must be set for a diÃerent select code in the range 3 through 7.

Once you have installed the HP 82335 HP-IB Card, do the following:

1. Add the appropriate line for your select code to the [386Enh] section of

your SYSTEM.INI Õle (in the C:nWINDOWS directory):

For Select Code: Add to SYSTEM.INI:

3 EMMEXCLUDE=0CC00-0CFFF

4 EMMEXCLUDE=0D000-0D3FF

5 EMMEXCLUDE=0D400-0D7FF

6 EMMEXCLUDE=0D800-0DBFF

7 (default) EMMEXCLUDE=0DC00-0DFFF

2. If there is a memory manager DEVICE line (for example,

DEVICE=EMM386.EXE) in the CONFIG.SYS Õle (in the root directory), you

need to modify it. Add a parameter to exclude the address space (for

example, X=DC00-DFFF for select code 7), as shown in the following table:

For Select Code: Modify in CONFIG.SYS:

3 DEVICE=EMM386.EXE X=CC00-CFFF

4 DEVICE=EMM386.EXE X=D000-D3FF

5 DEVICE=EMM386.EXE X=D400-D7FF

6 DEVICE=EMM386.EXE X=D800-DBFF

7 (default) DEVICE=EMM386.EXE X=DC00-DFFF
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3. Reboot your computer (press ÄCtrlÅ+ÄAltÅ+ÄDeleteÅ) and restart Windows.

If you have installed multiple HP 82335 HP-IB Cards, you must exclude

address space for each of them. For example, if you have installed two cards,

set to select codes 3 and 7, you'll need to add both of the following lines to

the [386Enh] section of SYSTEM.INI:

EMMEXCLUDE=0CC00-0CFFF

EMMEXCLUDE=0DC00-0DFFF

Also, if your CONFIG.SYS Õle contains the DEVICE line for EMM386.EXE, you

must add parameters to it as shown below:

DEVICE=EMM386.EXE X=CC00-CFFF X=DC00-DFFF
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This Glossary deÕnes some terms used in this manual. For a complete

glossary of HP VEE terms, refer to the HP VEE Reference manual or to

HP VEE Help.

Button

1. A button on a mouse.

2. A graphical object in HP VEE that simulates a real-life pushbutton

and appears to pop out from your screen. When you \press" a button in

HP VEE, by clicking on it with the mouse, an action occurs.

Cascading Menu

A sub-menu on a pull-down or pop-up menu that provides additional

selections.

Checkbox

A recessed square box on HP VEE menus and dialog boxes that allows

you to select a setting. To select a setting, click on the box and a

checkmark appears in the box to indicate a selection has been made. To

cancel the setting, simply click on the box again.

Click

To press and release a mouse button quickly. Clicking usually selects a

menu feature or object in the HP VEE window. See also \Double-Click"

and \Drag."

Component Driver

An instrument control object that reads and writes values to components

you speciÕcally select. Use Component Drivers to control an instrument

using a driver by setting the values of only a few components at a time.

Container

The package that is transmitted over lines and is processed by objects.

Each container contains data, the data type, and the data shape.

Context

A level of the work area that can contain other levels of work areas (such

as nested UserObjects), but is independent of them.

Glossary-2



Data Flow

The Œow of data through and between HP VEE objects. Data Œows from

left to right through objects, but an object does not execute until it has

data on all of its data input pins. Data is propagated from the data output

pin of one object to the data input pin of the next object. Data Œow is the

chief factor that determines the execution of a HP VEE program.

Data Input Pin

A connection point on the left side of an object that permits data to Œow

into the object.

Data Output Pin

A connection point on the right side of an object that propagates data Œow

to the next object and passes the results of the Õrst object's operation on

to the next object.

Data Shape

A pre-deÕned structure that deÕnes how data is grouped together (for

example, an array).

Data Type

A pre-deÕned structure that determines how data is organized and treated

by HP VEE (for example, Real or Complex).

Detail View

The view of an HP VEE program that shows all the objects and the lines

between them.

Direct I/O Object

An instrument control object that allows HP VEE to directly control an

instrument without using an HP Instrument Driver.

Double-Click

To press and release a mouse button twice in rapid succession.

Double-clicking is usually a short-cut to selecting and performing an

action. For example, double-clicking on a Õle name from File ¡¡) Open

will select the Õle and open it.

Drag

To press and continue to hold down a mouse button while moving the

mouse. Dragging moves something (for example, an object or scroll

slider).
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Entry Field

A Õeld that is typically part of a dialog box or an editable object, and

which is used for text entry. An entry Õeld appears recessed. For

example, the open view of the For Range object has entry Õelds where

you type values that specify the beginning, ending, and step values.

Expression

An equation in an entry Õeld that can contain the input terminal names

and any Math or AdvMath functions. An expression is evaluated at

run-time. Expressions are allowed in the Formula, If/Then/Else, and

Get Values objects, and in I/O transaction objects.

Grayed Feature

A menu feature that is displayed in gray rather than black, indicating that

the feature is not active or not available.

Hypertext

A system of linking topics so that you can jump to a related topic when

you want more information. In online help systems, typically hypertext

links are designated with underlined text. When you click on such text,

related information is presented.

Icon

The small, graphical representation of an HP VEE object, such as the

representation of an instrument, a control, or a display.

Instrument Panel

An instrument control object that forces all the function settings in the

corresponding physical instrument to match the settings in the control

panel displayed in the open view of the object.

Object

A graphical representation of an element in a program, such as an

instrument, control, display, or mathematical operator. An object is

placed in the work area and connected to other objects to create a

program. Objects can be displayed as icons or as open views.

Object Menu

The menu associated with an object that contains features that operate on

the object (for example, moving, sizing, copying, and deleting the object).
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Open View

The representation of an HP VEE object that is more detailed than an

icon. Within the open view, you can modify the operation of the object

and change the object's title.

Panel View

The view of a program in HP VEE that shows only those objects needed

for the user to run the program and view the resultant data. You can

create a panel view to meet the needs of your users.

Pin

An external connection point on an object to which you can attach a line.

Pop-Up Menu

A menu that is raised by clicking the right mouse button. For example,

you can raise the Edit menu by clicking the right mouse button in an

empty area within the work area. Or you can raise the object menu by

clicking the right mouse button on an inactive area of an object.

Program

In HP VEE, a graphical program that consists of a set of objects connected

with lines. The program typically represents a solution to an engineering

problem.

Propagation

The rules that objects and programs follow when they operate or run. See

also \Data Flow."

Pull-Down Menu

A menu that is pulled down from the menu bar when you position the

pointer over a menu title and click the left mouse button.

Scroll Arrow

An arrow that, when clicked on, moves you through a list of data Õles or

other choices in a dialog box, or moves the work area.

Scroll Slider

A rectangular bar that, when dragged, moves you through a list of data

Õles or other choices in a dialog box, or moves the work area.

Select

To choose an object, an action to be performed, or a menu item. Usually

you select by clicking with your mouse.
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Sequence Input Pin

The top pin of an object. When connected, execution of the object is held

oÃ until the pin receives a container.

Sequence Output Pin

The bottom pin of an object. When connected, this output pin is activated

when the object and all data propagation from that object Õnishes

executing.

Terminal

The internal representation of a pin that displays information about the

pin and the data container held by the pin. Double-click on the terminal

to view the container information.

Title Bar

The rectangular bar at the top of the open view of an object or window,

which shows the title of the object or window.

Tool Bar

The rectangular bar at the top of the HP VEE window which provides the

Run, Stop, Cont, and Step buttons to control HP VEE programs. The

tool bar also displays the title of a program.

Transaction

The speciÕcations for input and output (I/O) used by certain objects in

HP VEE. These include the To File, From File, Direct I/O, and

Sequencer objects. Transactions appear as English-like phrases listed in

the open view of these objects.

UserObject

An object that can encapsulate a group of objects to perform a particular

purpose within a program. A UserObject allows you to use top-down

design techniques when building a program, and to build user-deÕned

objects that can be saved in a library and reused.

Work Area

The area within the HP VEE window or the open view of a UserObject

where you group objects together. When you Open a program, it is loaded

into the main work area.
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